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Accessibility for Document Creators and Providers
Kevyn Barnes, Manager of Library Services, TxDOT Research Library

October 25, 2018

https://transportation.libguides.com/TLR
Audio call-in number: 877-336-1274; Access code: 5759713  

 

Welcome to the October 25, 2018, Transportation Librarians Roundtable: Accessibility for 
Document Creators and Providers, with our speaker Kevyn Barnes, Manager of 
Library Services, TxDOT Research Library. 
 
The webinar link is: https://transportation.libguides.com/TLR  
For participant audio: please call in at phone number 877-336-1274; when prompted enter 
access code: 5759713  
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For the librarians on the line, I hope this presentation will help you become an accessibility 
influencer or specialist for your organization. 
 
************** POLL **************** 
 
How Many of You… 
 
Create documents to post online? 
Create documents to share within your organization? (via intranet, email, or saved to a network 
folder.) 
Provide electronic documents to your customers? 
Post documents online, whether or not you are the creator? 
 
************** POLL **************** 
 
Who around you has an impairment to consider? 
 
Myself, my spouse/partner, child, or other close relative. 
My supervisor, co-worker, employee. 
A friend or close acquaintance. 
Somebody who has not told me. 
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• Public Internet Access *
• Behind a Login or Paywall **
• Intranet Access **
• Shared Folders
• Email
• Filed for Your Successors

 

 

Not just technical reports but also handouts, presentations, flyers. PDFs, Word documents, 
PowerPoints. 
 
* Gets the most attention, particularly due to laws that cover public facilities/accommodations 
and the wider visibility and impact. 
 
** After the revised Section 508 of the Rehabilitation Act rules, aka “Section 508 Refresh” 
(effective 2018), “agency official communication” must conform even when not public-facing 
https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-
refresh/final-rule/text-of-the-standards-and-guidelines#E205-content  
 
“For Section 508-covered ICT, all covered Web and non-Web content and software – including, 
for example, Web sites, intranets, word processing documents, portable document format 
documents, and project management software – is required, with a few specific exceptions, to 
conform to WCAG 2.0’s Level A and Level AA Success Criteria and Conformance Requirements. 
By applying a single set of requirements to Web sites, electronic documents, and software, the 
revised requirements adapt the existing 508 Standards to reflect the newer multifunction 
technologies (e.g., smartphones that have telecommunications functions, video cameras, and 
computer-like data processing capabilities) and address the accessibility challenges that these 
technologies pose for individuals with disabilities. “ --https://www.access-board.gov/guidelines-
and-standards/communications-and-it/about-the-ict-refresh/final-rule/i-executive-summary  
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Photo illustration by Senior Airman Kristin High, 
U.S. Air Force

Colorblindness

CC-BY-SA-4.0L “ICT training for blind teachers by It@School
Kollam” / Ivanjoseplavila

Vision Impairment
Photo by Kemberly Groue, U.S. Air Force 

Physical 
Limitations

Perceivable

Operable

 

 

(Auditory issues are not covered in my talk, but are important when dealing with videos and 
audio recordings.) 
“It is estimated that, while 15-20% of all individuals would benefit from receiving 
communications in an accessible format, only 3-4% of all documents are currently accessible. 
With an increasingly aging population, and an explosion in the growth of conditions such as 
diabetes and macular degeneration, the need for accessible documents will continue to 
increase dramatically.” --https://www.crawfordtech.com/blog/document-accessibility-for-print-
service-providers 
 
Perceivable: Can a person with colorblindness tell there is a link to more content? Is their eye 
drawn to it like a person who can distinguish colors? Can a sight impaired person see and tell 
what that important flowchart is on the page?  
If you are ignoring color, then you may be leaving people like Zuckerberg, Clinton, and Marco 
Rubio unable to interpret your supposedly high-impact graphics. 
Operable: Can they quickly scan and flip straight to the content they want? (own story about 
hovering over a small one letter link.) 
 
 
 
A 2008 “ study put together by Google based on data from the World Bank (WDI, 2008) and 
CDC.gov (NHI Survey, 2008), …[states there are] more users who are blind / low-vision than the 



population of Canada.” [around 30-32 million at the time] 
~http://www.interactiveaccessibility.com/accessibility-statistics (Source includes a graphic)   
 
Motor Limitations = traumatic injures, diseases, conditions (temporary broken hand, 
Parkinson’s, loss of limb, etc). Think of veterans. 
 
You’ve all heard the stats from other accessibility overviews, unfortunately this does not yet 
seem to resonate with a large majority of document creators. I was there once, too, so this is 
not a shaming but hopefully will be an eye opener. 
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“Plaintiffs filed 4965 federal 
ADA Title III lawsuits in just 
the first six months of  
2018…  If  the filings 
continue at the same rate, 
there will be close to 10,000 
ADA Title III lawsuits for all 
of  2018—a 30% increase 
over 2017.”

Source: Vu, M. N. (2018, July 19). Website Access and Other ADA Title III Lawsuits Hit Record Numbers. Retrieved August 
16, 2018, from https://www.adatitleiii.com/2018/07/website-access-and-other-ada-title-iii-lawsuits-hit-record-numbers/

 

 

There are many examples of ADA lawsuits and although only a modest number are based on 
electronic documents, they do occur. Commercial website content is most affected but= 
 
Janie Lin states in her recent article in July/August 2018 Information Outlook: “Comply or Be 
Punished” (Lin, Jaime, “Four Ways to Talk about Accessibility,” Information Outlook, vol.22 no.4, 
2018.) Also, “it makes sense to spend money on web accessibility, not on court cases.” 
 
Title II: State and local government: One landmark university case: In March 2017 UC Berkeley 
Removed More Than 20,000 classroom lectures and podcasts Online Videos From Public 
Access In Response To DOJ Captioning Demand.. “DOJ concluded in the findings that a covered 
entity subject to Title II has a duty to ensure content that it makes available to the public free of 
charge is accessible” https://www.adatitleiii.com/2017/03/uc-berkley-to-remove-more-than-
20000-online-videos-from-public-access-in-response-to-doj-captioning-demand.  
 
Title III: Public / commercial facilities Considering Title III, lawsuits filed due to accessibility 
complaints have risen. In only 6 months, over one thousand of those have been about 
accessibility of web content. (see graphic.) 
 
AT THE END OF SEPTEMBER 2019, “In a letter to members of Congress, the DOJ reaffirmed its 
longstanding policy that Title III of the Americans with Disabilities Act applies to website, though 
it declined to issue specific regulations on what websites need to do to comply with the law…. 
Key Takeaways:  The DOJ still believes the ADA applies to websites, even if it is not acting to 



issue regulations. The lack of regulations doesn’t mean organizations don’t need to make their 
websites accessible.  Organizations have a little flexibility in deciding how to make their 
websites accessible, but in most cases, working to meet WCAG 2.1 AA success criteria will be 
the best strategy. Litigation will likely continue to increase in the absence of specific 
regulations.” -- 
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Level Access presentation, September 13, 2018

 

 

State and local governments do get hit. 
 
According to a December 2017 article from adPharos “Since 2011, at least 142 local 
governments in the US have been sued due to website accessibility issues.” 
According to Level Access, under ADA Title II, the US DOJ reached 18 settlements from 2015-
2018 and 12 agreements in 2017 (mostly polling places and detention centers). Current DOJ is 
not pursuing much with current admin. 
Laws are highly individual between states, so lawsuits are usually brought by private parties, 
not lawyers conducting mass fishing expeditions. “Expect minimal federal enforcement in 
current administration. Expect increasing private enforcement at state level.” 
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U.S. factors—internationally there are other standards and regulations (but think about UN 
committee treaty on disabilities). 
 
*So here is my story*  : university policies. UT strengthened its policy in 2013/14. We had just 
developed on new online catalog and a contractor had just finished redesigning our Center’s 
website= 
=========== 
People often say “ADA” to refer to any accessibility issue, but that is not always correct. At one 
time, judges had ruled that ADA only referred to physical spaces, but recent trends have ruled in 
favor of websites being included. = At the end of September 2018, in a letter to Congress, the 
DOJ reconfirmed it’s stance that ADA does apply to websites. Because they have not issued 
exact guidelines as to what that means, lawsuits are expected to continue – Level Access 
https://learn.levelaccess.com/webmail/487581/223995521/fc5795ef67ff07e4f5b6d0de4fb47b
b549bd14b408ceb59766934dfc670766d6    
 
See https://www.w3.org/TR/WCAG20/ 
Web Content Accessibility Guidelines 2.0 
W3C recommendations from the Accessibility Guidelines Working Group (AGWG):    
Perceivable, Operable, Understandable, and Robust 
 



Section 508 refresh “… rule references Level A and Level AA Success Criteria and Conformance 
Requirements in WCAG 2.0 and applies them not only to websites, but also to electronic 
documents and software." 
Section 504: “No otherwise qualified individual with a disability in the United States, [shall] be 
denied the benefits of, or be subjected to discrimination under any program or activity 
receiving Federal financial assistance…” 
 
Most states now have web accessibility requirements codified in some way, which their state 
agencies must follow.  
 
“508, ADA, WCAG: What’s the difference?”  
https://www.logicsolutions.com/508-ada-wcag-accessibility-difference/  
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 Our web pages have been required to meet a minimum of 90% compliance with the Website 
Content Accessibility Guidelines 2.0 Level AA (WCAG 2.0 AA) standard, We were below 50%. I 
watch our accessibility scans monthly now. I suspect that in the next few years, the scans will 
apply to document attachments including PDFs so wanted to be ahead of the game. 
 
In February 2018, we received notice that no documents will be accepted into our university’s 
digital repository (Texas ScholarWorks) unless it is WCAG 2.0 compliant. This affects all 
theses/dissertations and faculty-submitted reports. .  
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In addition, many webmasters our now rejecting documents and other attachments that do 
not meet guidelines. Our library regularly submits TxDOT to TRID and requests duplicative 
archiving of the electronic documents with NTL. We received this rejection from NTL on 
Monday. Expect this to be a rising trend. 
  
Provide compliant documents and information to your IT when submitting information to add 
to website. With thousands of pages and other media files received, it would be impossible for 
webmasters to remediate each one even if we had the subject knowledge to do so. We depend 
on the creators to provide files with accessibility in mind. 
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Another argument to persuade document creators may be that accessibility provides SEO 
benefits. Higher ranking in online search results and increased exposure which could lead to 
more citations of the work. 
 
“Almost without exception, Google ranks websites with accessibility techniques included in 
metadata, content, visual design, and development better in organic search. Why? Search 
engine crawlers can’t see or hear, and they only use a keyboard, similar to many people with 
disabilities.”  --https://blogs.perficientdigital.com/2018/01/12/website-accessibility-benefit-
seo/  (Lisa Michael of Perficient Digital “Does Website Accessibility Benefit SEO?, January 2018) 
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On the left, an example of documents without metadata: I doubt these documents come up in 
many search results unless the search is extremely specific. 
To the right, an example of documents that our library remediated for accessibility. 
 
Which results would you rather see? If a screen reader can read it, then search engines will be 
able to read it better also. 
Google and other search engine algorithms may purposely rank accessible documents above 
inaccessible files. 
 
https://acrobatusers.com/tutorials/make-your-pdfs-work-well-google-and-other-search-engines 
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Your knowledge of  a document consumer’s needs. 

 

 

Not covering all requirements of any component in depth, but I’ll provide tips for several 
accessibility factors that you can start practicing on all your documents to show a good-faith 
effort. 
 
Also consider any special needs of people you know will use the document. 
 
 
 
 

  



Slide 15 

 

1. Use filenames that are descriptive but use web-safe punctuation only.

2. Describe hyperlinks correctly.

3. Use built-in tools to check for accessibility errors.

4. Set metadata properties for the document.

5. Add bookmarks to PDFs.

6. Images: Add Alt Text descriptions, including all text that is part of  image.

7. Check reading order—especially after inserting images, tables, etc.

8. Graphs: Check for color contrast & convey information by means other than 
color.

9. Ensure an acceptable color contrast between text and background.

10. Tables: Include column headers that repeat across pages.

11. Formatting: Avoid using tables & extra paragraph breaks solely for formatting. 

12. Formatting: Use built-in tools for bullet lists.

13. Formatting: Use headers and properly nest tag elements.

 

 

See presentation slide Works Cited for more thorough checklists for complying with regulations. 
U.S. Department of Education ED Accessibility Checklists for Word, PowerPoint, Excel, and PDFs: 
https://www2.ed.gov/web-guidance/accessibility-requirements.html. 
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2013&Improvement in Pavement Ride, Distress, and Condition Based on Different 
Pavement Types (Summary).pdf

1.  Sharing in email / documents / web pages / library catalogs:

http://[...domain name…]/reports/1314/2013&Improvement in Pavement Ride, Distress, and 
Condition Based on Different Pavement Types (Summary).pdf

2. Encoded for web browsers:

http://[...domain 
name…]/reports/1314/2013%20Improvement%20in%20Pavement%20Ride%2C%
20Distress%2C%20and%20Condition%20Based%20on%20Different%20Pavement
%20Types%20(Summary).pdf  

 

 

Consider filenames for ease of sharing (i.e., once it is web-based, people with mobility 
problems or on cell phones may need to copy & paste links that break due to spaces and 
unsafe punctuation. The longer the filename, the harder this is. If this link is pasted as-is on a 
website (e.g., in a bibliographic database/catalog), we often get calls from our web visitors who 
say a link is not working but this is almost always the cause. 
 
So I encode the URL before the screen reader will read the individual characters of the encoded 
portions (“ride-percent-two-C-percent-two-zero-distress-percent-two-c…”).  
 
http://next.fordham.edu/?p=230  
 
SEO and Google indexing factors of upper vs. lowercase (counted as separate files for analytics) 
& underscores (does not read words before and after as separate words). 
 
Safe characters: [0-9a-zA-Z-.,_]    "weird characters and spaces can cause other problems, most 
notably when trying to send a link to a particular file to download. 
 
“Unsafe: Characters can be unsafe for a number of reasons. The space character is unsafe 
because significant spaces may disappear and insignificant spaces may be introduced when 
URLs are transcribed or typeset or subjected to the treatment of word-processing programs.” -- 
Uniform Resource Locators (URL), IETG Network Working Group, 1994. http://www.rfc-
base.org/rfc-1738.html https://www.ietf.org/rfc/rfc1738.txt  



 
 
Patent office requirements, NIH submission requirements include limit on filename characters, 
but note that that includes the entire file path so filenames should not contain maximum. Entire 
threads and programs devoted to solving the problem of files that become inaccessible when 
filename is too long or has unsafe characters. 
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2013-rr-0-6673-s.pdf

2013-summary-improvements-different-pavement-types.pdf

http://[domain name]/reports/1314/2013-rr-0-6673-s.pdf

http://[domain name]/reports/1314/2013-summary-
improvements-different-pavement-types.pdf

 

 

Instead, connect all parts of the filename with a dash to eliminate spaces. 
Descriptive is good and helps SEO, too: https://accessibility.iu.edu/creating-
content/documents/general-guidelines/descriptive.html  
 Notice that if you do that, once it is placed on the web, its URL will not break and a screen 
reader will recognize each part as a word. 
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Links:
1. here.
2. Here.
3. Here.
4. Click here

Find the report here.

Versus

Download the summary report Improvement in Pavement Ride, Distress, and 
Condition Based on Different Pavement Types.

Find more information on the NCHRP 20-07(132) project page.

 

 

When including links in your report, consider both screen readers and colorblind factors. 
Problems in this example: link not underlined, color not what people expect and may not have 
enough contrast, and the link text is not descriptive. 
 
DO WHAT PEOPLE EXPECT=> underline links and do not underline things that are not hyperlinks. 
 
 The text that is hyperlinked is what is used by screen readers to list all of the links on a page. 

This is what blind users will hear if trying to flip through links on the page. 
 It is better to place the link on descriptive text. I probably should actually place the link over 

“summary report” as well. 
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PDF Techniques for WCAG 2.0:  https://www.w3.org/TR/WCAG-TECHS/pdf.html  

 

PDF Techniques for WCAG 2.0  : list of 23 accessibility items and techniques for remediating a 
PDF to comply with guidelines. 
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PDF properties generally just import the information from the Word document or other file that 
it was converted from. This usually means that there isn’t much information or it is not 
descriptive. 
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Next the properties settings 
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Within the Description area of PDF Properties.   Solid red arrows mean required. Dashed green 
arrows mean recommended but not required. 
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Initial view tab of PDF Properties 
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Show title instead of filename on the title bar. 
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Within the Advanced tab area of PDF Properties.  Setting the language is a requirement. 
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Within the Description area of PDF Properties. If you have suggestions for adding additional 
properties, please share. 
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Bookmarks for all major sections. These may import if you use proper headings in your Word 
document. 
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Built in Accessibility checker in Adobe Pro 
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Here I’m going to pick on one of our old internal research report templates. 
 
The Adobe internal accessibility checker doesn’t necessarily cover all requirements of 508, etc., 
but gets you started.  
** CLICK**  
Here, most items pass, but there are several that fail. 
 
Also, many things will have to be manually checked--color contrast, whether or not the alt text 
is meaningful, whether the headings are properly set (checker only makes sure heading tags are 
properly nested), and whether the reading order is correct. 
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• 6 (paragraph)
• 12 (image)
• 7 (blank spacing)
• 8 (image caption)
• 9 (heading)
• 10 (paragraph)
• 11 (list)

 

 

Reading Order has to be manually checked. 
 
Here there are a few things out of whack. #7 is an empty space where space/paragraph break 
was used for formatting purposes and the Image is the very last thing to to be read (#12). 
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Here, I deleted the Empty line (under the image for formatting) and used drag/drop to move 
the reading order of the image (I moved it under the Figure description).  
 *** Note: moving the reading order only affects the screen reader’s order, however, deleting a 
tag will also delete it entirely from the page.*** 
 
Doing this on a few pages may be no problem, but a 200-page document with a high number of 
illustrations would be very time-consuming. 
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Manual check shows 
that none of  the 
subheadings (section 
1.1, subsection 1.1.1, 
etc.) are marked as 
nested headings.

 

 

ADVANCED---Checking tags and containers to make sure headings are marked as headings, 
paragraphs as paragraphs, etc.  Also removing empty paragraphs that were used for 
spacing/formatting. This takes much care because if you delete the wrong tag element, it will 
also delete the text from the page. You may not just affect ADA accessibility but could end up 
inadvertently changing the content. 
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I will not touch this. 
See https://www.w3.org/TR/WCAG20-TECHS/PDF9.html for instructions. 
 
So what I want to show you is how to create these accessible features before the document is 
ever converted to a PDF 
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I’ll be using my own presentation to illustrate some of these points. 
 
In PowerPoint, switch to "File" on menu bar 
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File Options include "Check for Issues" then "Check Accessibility" 
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Now you have a Window that show definite accessibility errors as well as things you might need 
to check manually 
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Same process for MS Word documents 
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Before we go any further:  if nothing else is remembered, remember this one warning to avoid 
wasted time. =>  
 
 
 

  



Slide 44 

 

 

 

“PRINT to PDF” strips all tags and other accessibility features from your Word, PowerPoint, and 
other documents, just like a document printed on paper. 
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Use “Export” or “Save As…” instead. Options may depend on if you have Adobe Acrobat Pro or 
not. 
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Use “Export” or “Save As…” instead. Options may depend on if you have Adobe Acrobat Pro or 
not. 
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When you click on the item in the Accessibility checker results, you are taken to the slide with 
the error. 
 
 

  



Slide 49 

 

 

 

Right click image to get “Format Picture” option 
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Screen reader already notes it as an image, so just describe what the image conveys. Use 
punctuation. Position image in line with text, not with text wrapping. 
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Same exact steps in MS Word, same icon in the Format Picture display. 
 
 

  



Slide 53 
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Screen readers can not interpret smart art and Alt Text can only be added for individual pieces 
of the graphic. Grouping does not change this. 
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Better to screenshot / snip the graphic and then apply a description to the entire image. Save 
the version that can be modified as an extra slide or page at the end of a document. 
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Same issue in MS Word… Note that each section of text is also seen as an image by the 
computer. 
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With same solution in MS Word. 
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Use the built-in Insert Table method. 
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Right click on the table to get to “Insert captions” option 
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Add caption. 
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Caption is now added above the table. 
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Here I have filled out some information. Select the header row, then go to “Table Tools > Design 
> Header Row.” 
Notice that on the next page, there is no way to know what the column headings are. 
 
 

  



Slide 65 

 

 

 

Go to “Table Tools > Layout > Repeat Header Rows” so the headings are repeated. 
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Slide 67 

 

 

 

Next, let’s check reading order issues. 
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Home > Arrange > Selection Pane 
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REVERSE order!

 

 

The first column of text will be the 4th section read. 
IMPORTANT: “Use the Selection pane to set the order in which the screen readers read the slide 
contents. The Selection pane lists the objects on the slide in reverse order. When the screen 
reader reads this slide, it reads the objects in the reverse order listed in the Selection pane.” 
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The 3rd picture is the 2nd item that will be read. 
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Here, I have reordered the text and pictures so that text is read after the image that it is 
associated with. Simple drag and drop in the Selection pane. 
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In this case, it might have been easier to rename each element before dragging and dropping. 
Makes it easier if you still plan on reordering itmes. 
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Heading structure must be properly structured. In Word, if you will be converting to PDF, use 
only one “heading 1” <h1> in the document (instead of “title”).  
In this case, our template needs to be changed so chapter titles are <H2> and so forth. 
 
Here, you’ll see how to change the overall styles in your document so that you don’t have to 
rely on empty paragraphs for spacing and headings are automatically recognized. 
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Dropdown to view list of style categories and to customize your styles 
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Modify an individual style item here 
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This is where you adjust formatting options for consistency 
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Graph 1 cannot be interpreted 
in grayscale nor by a person 
with Monochromacy or
Achromatopsia colorblindness.

Graph 2 uses shapes in addition to 
color to convey the information. It 
can be interpreted in grayscale and 
by somebody with Monochromacy / 
Achromatopsia.

 

 

Authors may be excluding the Bill Clintons, Mark Zuckerbergs, and Marco Rubios of the world 
from understanding your visualizations 
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Free Colour Contrast Analyser allows you to check color-blind accessibility directly within MS 
Word or other office application. 
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Lets say we want to check whether this SmartArt can be read be a colorblind person. 
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Open up Colour contrast Analyser and use the color picker. 
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Open up Colour contrast Analyser and use the color picker to pick up the foreground and 
background colors. 
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Open Colour Contrast Analyser and use the color picker to pick up the foreground and 
background colors. 
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Colour Contrast Analyser tells you immediately if it passes or fails. This one passes most 
guidelines. 
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This one fails. 
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A  neat option in the tool is the ability to see results for different  types of colorblindness. 
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The point is that you would want to use a darker background color or different color them 
altogether.  There are some resources in the works cited handout to help with color themes. 
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In the Design tab, you can change preset color themes or customize. 
 
 
https://venngage.com/blog/color-blind-friendly-palette/ 
 
COLOR PALETTES FOR COLOR BLINDNESS --http://mkweb.bcgsc.ca/colorblind/ 
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Sometimes you have to be careful about your themes… the built in themes are not necessarily 
accessible. When I changed this presentation’s theme, the hyperlinks did not have enough 
contrast with the slide’s black background. 
 
In that case, you need to customize your color scheme. WebAIM has a Link Contrast Checker at 
https://webaim.org/resources/linkcontrastchecker/ 
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You can play around with different colors and every slide will be automatically updated with 
that color. 
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https://tinyurl.com/accessibility-ref
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Caption files with proper punctuation don’t just happen automatically. The computer-generated 
files can also have embarrassing misinterpretations of what the person said. 
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Very easy to review the video on YouTube and create a new or edited transcript / caption file for 
shorter videos. Can also upload a file created outside of YouTube. 
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November 8, 2018
TLR Listening Session: Tools for Impacting 

Research
Roberto Sarmiento and Rachel Cole, 

Northwestern University Transportation 

Thank you for attending
Join us Twice in November!

For Past Episodes, Visit the TLR Archive at: 
https://rosap.ntl.bts.gov/browse/collections

November 15, 2018
Tribal Libraries and Transportation 

Resources 
George Franchois, Director of the U.S. 

Department of Interior Library

 

 

Thank you for attending 
Join us Twice in November! 
First: November 8, 2018, TLR Listening Session: Tools for Impacting Research; featuring speakers 
Roberto Sarmiento and Rachel Cole, Northwestern University Transportation  
Second: November 15, 2018; Tribal Libraries and Transportation Resources, with George 
Franchois, Director of the U.S. Department of Interior Library 
For Past Episodes, Visit the TLR Archive at: https://rosap.ntl.bts.gov/browse/collections  
 
 
 
 

 


